1. Using Advanced Filter to anothersheet

Advanced filter can only filter to the active sheet.

The active sheet can fApull 06 informat.i
information to another sheet.

Microsoft Excel

But by using the Advanced Filter on the Data tab:

Home Insert Page Layout Formulas Data Revii
- |b3] Connections | 4 N % Clear
2] ARFIR
23T Properties KJ Reapply
rnal | Refresh il Sort Filter
- All~ == Edit Links W
Connections Sort & Filter

you canpull information to the active sheet:
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After clicking OK (notice théiUnique recordsis checkedabovg:
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2.Sel ect all 00s;
Suppose you had a worksheet which looked something like the following, and you
wanted to select all the celisntainingt he wor d
A | E | ¢

1 Description

2 m35-c summary input

3 m35-c gl acount #

4 m35-c gl description

5 m33-c amounts

B m35-d description

7 m35-d summary input

g m3a-d gl acount #

9 m33-d gl description

10 m33-d amounts

11 m80 gl acount #

12 m80 gl description

13 mi0 ye balance

14 mB0 amounts paid after

15 mB1 gl acount #

16 mB1 gl description

17 mi1 ye balance

18 m81 amounts paid after

19 m8Z gl acount #

20 m8Z gl description

21 mi2 ye balance

22 mB2 amounts paid after

23 mB3 gl acount #

24 mB3 gl description

25 mi3 ye balance

26 m83 amounts paid after

27 m84 gl acount #

20 m84 gl description

29 mi4 ye balance

an mld amnunts naid aftar
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If you use Home tab, Find and Select from the Editing section, then Find (or, simply

press Ctrl/F):

Sort & [Find &

™ Filter = |Select =

4 Eind..

2ic | Replace...

=  GoTo..
Go To spedial..
Formulas
Comments
Conditional Formatting
Constants
[rata Yalidation

kg Gelect Objects

"_ﬂ'[} Selection Pane...

t ypeamnmonunit so

Find and Replace

Fird | Replace |

( wi tthloeunt o lhiec ky utonhee shi,nd
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Find what; Iamu:uunts| j
Opkions = |
Find &ll | Eind Mexk I Close |
Biook | Sheet | Mame | Cell | Yalue -
<= client organizer ko ewp +E35 Mao-C amounts
hydracllenturganlzermapE xls  client organizer to ewp $£3410 m35-d amounts
hydraclientorganizermapz . xls  client organizer ko ewp $E414 ma0 amounts paid after
hydraclientorganizermapz . xls  client organizer ko ewp $E415 mal amounts paid after =
hedraclientorganizermapz. xls  client organizer ko ewp $Bfz22 maz amounts paid after
hydraclientorganizermap2.xls  client organizer ko ewp $B426 ma3 amounts paid after
hydraclientorganizermapz . xls  client organizer ko ewp 46430 mad amounts paid after
hydraclientorganizermapz . xls  client organizer ko ewp 6434 ma5 amounts paid after
hedraclientorganizermapz. xls  client organizer ko ewp $B435 ma6 amounts paid after
hydraclientorganizermap2.xls  client organizer ko ewp 3442 ma7 amounts paid after
hydraclientorganizermapz . xls  client organizer ko ewp $5446 maa amounts paid after
hydraclientorganizermapz . xls  client organizer ko ewp 5450 ma9 amounts paid after
hedraclientorganizermapz. xls  client organizer ko ewp $3454
limmb s m i b e Aot
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H e rs ¢hé twist: instead afelectingthe items in the found list, you can use ctrl/A (or

shift click the last item in order to select from the alrea€lgcted item through the item

youdre now selecting, or even temdseléctecin
the list will also be selected in the worksheet:
A =] ¢c [ o | E | F | & H | 1 | J | K

L Drescription

2 mdS.e summany input

3 miS.e gl acount # |M 2%
4 mib.c gl deseription Regiace
5] m35.c amounts = |

6 | m35.d description Fgdwhat:  |amounts| =]
Fll| md5.d summary input

8 m3%-d gl acount &

a miS.d gl description

10 ma5ad amounts

1] mil gl acount &

12| mil gl deseription
13 mBl ye balance

14 mil amounts paid after

15| 1 gl st ¥

16 mil gl deseription

17 mé1 ye balance
18] mi1 amounts paid afier

18| mi2 gl acount ¥

N méZ? gl deseription

21 mi ye balance
EI mi2 amounts paid afler

3| mi3 gl acount &

24 mi3 gl description

P} mi3 ye balance
|26 m#3 amounts paid after : !
Frll méd gl acount & 4 cebls) Fonred &

Now, when you close the dialog box, the cells will still be selected!

" Special thanks to Jan Karel Pieterse for this tip!
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Now, suppose your worksheet looks something like the following, and you want to

change all the yellow cells to beld (and still yellow):

A,
Form Name
FORM 5471
FORM 5471

FORM 5471

FORM 5471
FORM 5471

00|~ ||| = LR —=

10 |[FORM 5471
11 |[FORM 5471

13 |[FORM 5471
14 |[FORM 5471

16 |FORM 5471
17 |[FORM 5471
18 [FORM 5471

20 [FORM 5471
PTIFMRM 5471

Selecting by texedsownwoher
find by Format. Note the Format button at the,tou may need to click the Options

button)

Find and Replace

Find | Replace

? X

Find what: || V| |N-:| Format Set | [

Format. .. v]

[ ] Makch ertire cell contents

| Fndal | | Findhext |

[ Close

]

featbue DieExcel




Font Border Fill Prakection

Category:

eneral Sample
Mumber
Currency
Accounting aGeneral format cells have no specific number Format,
Date

Time
Percentage
Fraction
Scientific
Text
Special
Cuskarmn

[ hoose Format From Cel... ] I (04 l [ Zancel ]

Inthisdal og, you can enter all the properties o
find, but thereds also an easier way: <click
Cell é0! When you do this, youdll see a speci
selection cursor but with an eygropper next to it!



When you click on the cell containing the
preview of the formatting in the dialog box, and yaun combine this with text to find as
well!

Find | Replace |

Find what: | j Preview™ |

Within: |5heet vI ™ Match case

™ Match entire cell contents
Search: IEy Rowes vI
Look: in: IF::urmuIas TI Cptions << |

Find All | Find Mexk | Close |

Hereds the result

A | 8 I ¢ | o [ E [ F | 6 | H [ _
1 Form Name 2/
2 |FORM 5471
3 |FORM 5471 Find | Replace |
g FORM 5471 Find what: | | [ Preview ] _ Fomat... -]
B
7 |FORM 5471
8 |FORM 5471 Within:  |Shest +| I Match case
g search: Im [ Makch entire cell contents

10 |FORR 5471
11 |[FORKM 5471 Look in: IFDrmuIas vI Options << |
13 |[FORM 5471 Frdal | [ Endnex | Close |

14 |[FORR 5471
15 Boak | Sheek | Marme | Cell | Yalue | Formula |*-
16 |[FORM 5471 C
17 |[FORM 5471
18 |FOREM 5471

20 |[FORM 5471
21 |[FORM 5471
22 |[FORM 5471




3. Cut/Copy, Insert Paste by dragging borders!

In order for this tip to work, you need to have the setting checkdehfainle fill handle
and ell drag-anddrop turned on (which is the default setting anywayjs is in the
Office button, Excel Options, Advanced section, as shown here:

Excel Options

Popular e . A .
P j Advanced options for working with Excel.
Formulas
Proofing Editing options
Save After pressing Enter, move selection
Achanced | Direction: | Down *
|:| Automatically insert a decimal point
Customize
Add-Ins Enable fill handle and cell drag-and-drop

Alert before overwriting cells
Allow editing directly in cells

Trust Center

Resources Extend data range formats and formulas

Enable automatic percent entry
Enable AutoComplete for cell values

Zoom on roll with IntelliMouse

EOOREE

Alert the user when a potentially time consuming operation occurs

When this number of cells {in thousands) is affected: [33554 5

To cut and paste a range, seléeind drag the border (the cursall change to a cursor
with a 4headed arrow).

To cut andnsertpaste a range, drag a range by its boadeithe shift key hkel down.
You will see an indication of where the range will be inserted:

A | B | ¢ D
1 36 45 1/1i2003
2 40 50 _2/1/2003|
3 44 55 3/1i2003
4 48 60 4/1/2003
5 52 65 5/1/2003
6 56 70 61112003 2=

The grey line indicates where A1:C2 will be cut and inpagted. The intellisense shows
that the new location will be at A5:C6.

If you hold the ctrl key down with either of thed actions above, the cut becomes a
copy.



4. Use Fill-handle to insert or delete rows

Did you know that holding the shift down while using the fill handle shift cells?
Well, now you do! Letdos take a | ook.

1. Hold shift key while dagging Fill Handle. You will see a new shape to the fill
handle, a split vertical-Readed arrow.

If drag down you will insert rows

If drag up you will delete rows

If drag right you will insert columns

If drag left you will delete columns

abrwn



5. Shift/find finds backwards

This is great for finding the last department in a list, for example:

B | ¢ | D |

Department
Aect

Acctg Find | Replace

ACCHd || ripg e
Acctg
Accty
Accty
Acctg
10 |Accty
11 |Accty
12 |Accty
13 |Accty
14 |Accty
15 lAccta

WO 0~ || (k=

Eind Mext

How can you tell where the last Acctg department is? Use&@dlect from the Home
Tab (or ctrl/F) and before clicking Find Next, holdteeh i ft key, and youdre
click!

- -

A B | ¢ | D |
263 |Acctg 1
365 Accty
265 | Acctg Find and Replace
266 Acctg Find Replace
ig; iggtg Find what:
269 |Accty
270 |Accty
271 |Acctyg
272|Accty Findall | | Find Hext
273 |Accty
274 |Accty
275 |Accty
276 |Bowling department




You can use a wildcard to search &mythingbackwards, so starting from cell A1, you
can find the last row or column!

Find and Replace EJ
Find | Replace | Fram cell Al, finding an * backwards and
Findwhat: | | @ selecting "By Rnws. will select the last row
' (Excel's ctrlfend iz often too far downl)
Then, reselecting cell Al and changing the
Within: [shest v | [ Match case dropdown to "by columns” will find the last
- = |
search: [oyRows [ [ mateh used column!
Lok, in: [ Cpfions <<

| Fndal | | Eindext | | Close |




6. Combining cells with Paste Special/Skip Blanks

Yo u Oseeethe Skip Blanks feature in the Paste Special dialog, but do you know how to

use it? It refers to the range being cogidaank cells in thesourcew o n 6 t
thereceivingrange.
Example:

Al:A7 has a,,c,,e,,g and B1:B7 has b,,d, f,,h

Copy B1:B7, select ARight/Click, Paste Special

B D
1 a b _E
2 L]
3 |cC d | Cut
a 3 Copy
5 e [, Paste
B Paste 5pecial...
7B Insert Copied Cells...
8 Delete...
9 Clear Contents
with Skip blanks:
A | B c | b | E | F
1 b
2 ! —
3 d Paste Special E] E|
4 Paste
5 f O al ) Walidation
6 () Formulas i Al except borders
7 h () Yalues ) Column widths
8 ) Formats ) Formulas and number Formats
5 ) Comments i) values and number Formats
Operatian
10 (%) Mane ) Mulkiply
1 ) add ) Divide
12 () subtract
13
14 [“iskpblanks: [ Transpose
15 I ] 4 I [ Cancel
16

erase

cel

¢
R



the resul t:
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7. Right-click drag the Fill Handle for several options

If you use the fill handle and drag with the righbuse down, you will be prested with
a dialog containing several options when you let go:

A | B C D | E
36 45: 1M/2003
40 50: 21172003
My f‘?'I'II'I‘QI
Copy Cells
Fill Series

Fill Eormatting Only

Fill wyithout Formatting

Fill Days

Fill Wweekdays

Fill Months

Fill ¥ears

Linear Trend

Growth Trend

Seties. ..

B o | | o — | — —
e lon gl e oo sam=

What the original selection contains will determine what options are available in the
dialog:

A B | C |
36 45 1172003
40@ 50 2M72003

2
Copy Cells
Fill Series

Fill Eormatting Only

Fill Withaut Formatting

Fill D=

Fill Weekdays

Fill MMonths

Fill Years

Linear Trend

arowth Trend

) [N U PN N L Y
..mhmm_\cmmﬂmmhmm—\

Series...




Notice that in the first example, dates were selected, so the middle section of the dialog
(filling dates) is available, but the second example has the middle section disabled
sel ected.

because
quite useful:

dat es

wer enot

A
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D (D |~ | (O | B | (D=

Cel |

Weekdays

weekends.

36
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Cloés fil
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1712006
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1/18/2005
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8. Defining names for large norcontiguous ranges

If youneedtonameamuir ea range, youobre | inmeted to ab
definition. This can cause problems as seen here:

Il n this worksheet we want to give a name to
easy to clear them or add them up, or refer to them in some way.

A B c D E F G H |||

1 Data: 2

2

3 ) ) Data: 21 Data: 27

4 =

5 Data: 25 1

6 Data: 12

7 Data: 14

8 Data: 89

g Data: 63 Data: 81

10 Data: 50 Data: 70

11 Data: 33

12 Data: 88

13

14

15 Data: 30 Data: 105

4 4 » v | This tab has a long name - Sheet2 Sheet3 %0 [ m | [
Al so notice the tabds name is quite | ong.
Okay, we want to name the cell skE5 Speamigilwe sel ect

and making this selectipn

Go To Special

Sielect

) Comments () Row differences

(%) Constants () Column differences

() Formulas () Precedents
Mumbers () Dependents
(o

Logicals
Errors () Lask cell
() Blanks () visible cells anly

() Current region () Conditional formats
() Current array () Data validation
() Objects

[ Ok l [ Cancel




That is, weodre selecting const abdfi®m whi ch are
Name from the For mul a $erésalting narBeuvere tpoolang | I f i nd
then Excel wondét even bring up the dialog! Y

by using VBA! Press Alt/F11, getting you to the VBE (Visual Basic Environment), then
Ctrl/G (the immediate pane), then type this elyaeind press enter:

Selection. Name = fAMyDat ao

Then Alt/Q will bring you back to Excel. Now the name MyData will accurately refer to
the desired cells.



O.Whatist hat 1, c2e | see |

TheNew Windowbutton fromthe Window section of the View taiveates anbter
Afvi ewo of the same wor kbook:

View Developer Add-Ins

L% Er-':l E25 New Window | [ | 1] % %

----- e = Arrange All | N
Zoom 100% Zoom to . Save Switch
Selection lﬂ Freeze Panes~ [] | 14 Workspace Windows ~
Zoom Window

You can use it to:
AView separate sheets of the same workbook at the same time:

| A - fe | =Sheet1!A1
2 Books:2
A B C D E A B C D
1 Cool! 1 |Cool! !
2 2
3 3
4 4
5 5
il il
7 7
8 8
9 9
10 10
11 11
M 4 » M| Sheetl - Sheet? . Sheet3d . ¥J M 4 » M| Sheetl | Sheet2 SM




Aview the same sheet but remote areas simultaneously:

Al - [ ﬁr| Cool!

B Books:1 - = X

A B C D E u ") |
1 [Cool! .I 99998
2 99999
3 100000 Cool!
4 100001
3 100002
o
7
8
9 100006
10 100007
11 100008
4 4 » M| Sheetl ~ Sheet2 4 4+ M| Sheetl < Sheet? -5

AView formulas and valuesimultaneously:

Al - [ fe | =Sheet1!a1
5] Bookh:1 - =X
A B C D fil
Cool! _l =SheetllAl

1 1
2 2
3 3
4 4
3 3
b 6
7 7
8 8

9
M4k H Sheat2 . Shell

9
M 4k M Sheet2 - Sheet3

To rejoin the windows, close theffieei ndow by
buttoriClose, because the separate windows would save and reopen that way. You can
useNew Window many times and get as many windows as you wish efdhéook.

Think of it as if you were looking out your physical window and seeing parked cars. Now
move to another window and look at the same cars. You have a slightly different
perspective of t heofwshaamed so bg oeicntg. ofnh ahtebrse .k i nd



10. Double-clicking tools

Doublec | i ck the format painter

click it again.

keeps

t

nalivef

Doubleclick ashapeool (rectangle, for example) to draw several without revisiting the

tool. (From the

Shape button on the Insert tab):

Insert Page Layout Formulas Data Review

(XD a ¥k e g

Elgl
Ehai| PR [
Ficture Clip |Shapes|Smartart | Column  Line Pie

Art

Ilust

Press the esc key to stop that feature or click the tool again!

Recently Used Shapes
ENNOCOALLD S G
CRRTAY

Lines
SNSNTLTL T G %
Rectangles

[ () [ (o (ol [y ] ] (]

Basic Shapes
EoAMNITASTGOOO®
@btouOr by o oo
OO@PHEOY & [ <D™
(D0 147

Block Arrows
DAL RI T
€ v »kRElaif
LA



11. AutoSum Tool features

Suppose you have a block of cells like in this illustration, containing numbers which you want to

entet he totals both on the right and below; tha
something like this:
A B | ¢ | D | E F

1) 6 64 30 _ 46/=SUM

2 B4 g5 87 74 | suMinumberl, [nur

3 14 69 78 97

4 88 42 71 6

5 5 32 71 62

B 57 47 65 2

7 50 5 63 92

8

1. Click in E1 and click the Sum to¢bn the Editing section of the Home tab)

- A
720 &4
i |
. Sort & Find &
27 Filter~ Select~
Editing and press enter, or doultkck the Sum tool.
2. Click the fill hardle in E1 and drag to E7, or double click the fill handle in E1.
3. Select cell A8, click the sum tool, enter the formula, select the fill handle, drag to ES8.

Hold on to your hats. It can be done in one click:
Make this selection as shown in the illustration

A | B | © | D | E

1 65 54 30 46
2 84 85 87 74
3 14 69 78 97
4 88 42 71 6
5 5 32 71 62
6 57 a7 65 2
7 50 5 63 92
8

Select an extra blank column and row.
Click AutoSum Tool once, and youbre done!
|  k n o whavetp tryuit!



Next, if you have a mukeell selection, as in this illustration:

A | B |
1 60 60
2 54 66
3 58 28
4 57 16
5 9 14
3 I 91
7 34 29
8 70 16
9 62
10 70 7
11 66 68
12 95 77
13 76 13
14 46 84
15 32 70
16 18
17

A singleclick of the sum tool will put the correct totald in



